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Segmenting Images
Segmenting medical images can sometime be tricky, specially with MRI images. With MRI,
we don’t have specific numerical pixel values for the different tissues. Worst, the values
for a tissue may change from slice to slice, or even inside the same slice, due to the
inhomogeneity of the magnetic field.  For some clear-cut regions, such as the arms and
legs, we can still use the threshold segmentation technique.  For most slice however, we’ll
use either the Morpho Mode, a combination of Threshold and Morpho or the Snakes.  All
of these techniques are based on the gradient of the image and are less sensitive to the
image inhomogeneity.

The following tutorial will guide you through a series of exercises that will help you
understand the different segmentation techniques used in sliceOmatic.

Segmenting Images with Threshold

• Start sliceOmatic, (Start/Programs/TomoVision/sliceOmatic).  

For this exercise, we will need the image Tutor_Segment.gli from the Tutorial directory.

• Click on the “File Open” button form the “File” menu.

• Select the Folder 
“c:\Program Files\TomoVision\Tutotrial” from
the folders list.

• Select the file Tutor_Segment.gli from the
file list.

• Click the “OK” button.
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We will need 3 tools:

• From the “Tools” menu, select the tools: “Image Info”, “Pixel Info” and
“Color Scheme”

You may want to increase the image contrast a bit:

• In the “Color Scheme” tool’s controls, move the “white”
slider to a value of 512.

In order to “see” the segmentation, we will need to select a color scheme where the
threshold colors are visible on the image.

• Click on the Mix button from the Color Scheme Tool.
(Alternatively, you can use the F2 key from your
keyboard.)

Now go in the Segmentation Mode:

• From the “Modes” menu, click on the “Segmentation” button.
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The “Grey-Level Segmentation” controls are now displayed.  The first thing to do is to scale
the histogram so that we can see some relevant information.  (By default, the histogram
is scaled to show the entire graph.  But since they are so many pixels at 0 (the background
value), we’ll need to scale it up.) 

• Moving the “Histo” slider about half-way in its vertical
course should yield a good scaling.  We can now clearly
see a serie of peeks for the background (0 near the left
edge of the graph, the muscle and the fat.

• Move the Threshold 1 slider to the valley
between the first 2 peeks (background
and muscle)  (The threshold value
should be between 40 and 60).

• Move the Threshold 2 slider to the other
side of the muscle peek (around 250)

Note: If you want a more precise control of the threshold values than what can be
accomplished with moving the sliders, you can use one of the following techniques:
While the cursor is over the threshold slider, the Insert/Delete/Home/End/Page Up
and Page Down keys can be used to change the threshold values by +-100, +-10
or +-1.  You can also set the threshold values from the command line.  The
command “Segment: threshold 1 50" will fix the threshold 1 to 50. 

• Alternatively pressing the F1 and F2 keys will change the Color Scheme from Mix to
Grey, enabling you a good view of the segmentation that will be performed by the
thresholds.

• Click on the Compute Segmentation button to segment
the image.  This action will automatically create the TAG
image associated with this Grey Level Image.
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Some pixel were not tagged correctly.  Pixels on the outside
of the legs are tagged in red as muscle, when clearly, they
are not.  Some pixels inside the leg will stayed black where
they should be muscle and the femur is a mix of black,
muscle and fat.  These errors will now be corrected in the
Edit Mode.

• From the “Modes” menu, click on the “Edit” button.

Getting rid of the red pixels outside the leg:

• Click on the red 1 button to select the TAG 1 color (alternatively,
the key 1 from your keyboard or keypad will also select the TAG
1 color).

• Move the cursor to a region outside the legs (pixel 50x50 would
do fine)

• press the Enter key. (The Enter key is use to flood a region with
the selected color.)

This has flooded the entire background with the red color, eliminating
the difference between the pixels falsely tag in red and the
background.

• Click on the grey * button to select the TAG 0 color (alternatively,
the key 0 from your keyboard or keypad will also select the TAG
0 color).

• Move the cursor to a region outside the legs (pixel 50x50 again)
• press the Enter key.

We now have eliminated the red pixels around the leg.
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Getting rid of the holes inside the leg:

• Press the Close 1 button.  

The Close 1 button will fill all holes of 1 pixels, the Close 2
button will fill holes up to 2 pixels wide, also, the Open 1 and 2 buttons will remove pixels
that are alone or in small clusters.

Getting rid of the bone:

• Press the F2 key to make sure we are in Color Scheme Mix mode.

• Click on the grey * button to select the TAG 0 color.
• Select the Brush #3 by clicking on the 3rd button with a

circle image at the top of the Edit Mode controls.
(Alternatively, you can use the F7 key to select the 3rd

brush.  Keys F5 to F8 select the first 4 brushes.)

We are now going to paint the bone region with the TAG 0:

• Scale the image to have a good view of the region to edit
(a scale of 5 should be good.)  You can scale the image
with the + button in the scale window of the Image Info
tool, or with the + key of the keyboard.  If you used the +
button, you will then need to move the image around with the X and Y sliders.  If you
used the + key, you then have the possibility of placing the cursor over the region you
want to scale before pressing the key.  The pixel under the cursor will not move when
the image is scaled, limiting the amount of adjustment you need to do afterward.

  
You will notice that your cursor is surrounded by a circle.  The
circle is your brush, all pixels inside this circle will be painted
by your brush when you click on the left mouse button.

• While pressing the left mouse button, move the brush over
the bone.
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The pixels under the brush will lose their color, leaving only the Grey Level Image.

• If you made a mistake, pressing the right mouse button
will erase the modification you have done and bring back
the previous color under the brush.

• Pressing the middle mouse button will momentarily
change your brush for a big square brush.  Using this in
combination with the left or right button is very useful if you
want to paint or erase a large region in a single stroke.

How does the Erase and Undo work ?

To understand how Edit work, we will have to clarify the
difference between the Load and Undo buttons:

The first time you paint an image, the original image is automatically loaded in the erase
buffer.  This erase buffer is used for the erase function of the mouse (the right mouse
button).  Each time you press the Load button, the current image will be copied in the
erase buffer.  There is only one erase buffer per image.  

There is no undo on the brush strokes, what you can undo are the load operations,
bringing back the image from the previous load.  In some occasions (such as the first
time you paint an image), sliceOmatic will automatically load an image, this will appear
in the Undo/Redo menu as “Edit Paint”or “Morpho Paint”.  Manually loading the image
with the Load button will result in an “Edit Load” or “Morpho Load” entry in the
Undo/Redo menu.
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Segmenting Images with Region Growing

In this exercise, we will use the region growing technique to segment the sub-cutaneous
fat in a MRI image of the abdomen.

• Start sliceOmatic, (Start/Programs/TomoVision/sliceOmatic).  

For this exercise, we will need the images Tutor_Morpho_1.gli from the Tutorial directory.

• See section 1.1 for details on how to open an image in sliceOmatic.

This exercise is entirely done in the “Mix” color scheme.

• From the Color scheme tool select the “mix” button.

Now open the Region Growing Mode’s interface:

• From the “Modes” menu, click on the “Region Growing” button.

The images are segmented 1 tag at a time, the current tag is selected from the choice of
127 buttons.

• Select the smallest brush.
• Select the red “1" button.
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How does Region Growing work ?

The 3 region growing sub-modes (Paint, Grow 2D and Grow 3D) work on the same
principle: To be tagged with the current selected color, a pixel must meat the 3 following
conditions: 

1 The pixel must have a grey level value that is between the lower and upper limit
range.  These values are fixed with the help of 2 sliders and the image’s histogram.
There 3 modes for each of these limits: 

OFF in this case, the limit is disabled. This is equivalent to fixing this limit to its
minimum value for lower limit or maximum for the upper limit.

ON The limit is set to a fix value.  The possible range of these values is the
range of the grey-levels in the image.

REL The limits are relative to the value of the pixel under the cursor.  Moving
the cursor will change the actual value of the limit.

2 The pixel must not already have a tag value that is greater or equal to the selected
color.

3 The last condition is different for the 3 sub-modes:

Paint Only the pixels under the brush are candidates for tagging.
Grow 2D The tagged pixels form a connected region starting with the pixel under the

center of the brush.  To be tagged, a pixel must be on the same image as
the brush. It must be contiguous to other pixels meeting conditions 1 and
2. And the region can not have a radius of curvature smaller than the
current brush.

Grow 3D Same conditions as Grow 2D but the region can also propagate from
images to images.

There are 3 sub modes in the region growing mode.  The first, “Paint” only affect the pixels
under the cursor.  The second “Grow 2D” affect a region of the current image centered on
the cursor.  The last “Grow 3D” can affect multiples images at the same time.

• Select the “Grow 2D” mode.
• Select the “ON” value for the lower limit.
• Set the lower limit to about 250.
• Leave the upper limit to “OFF”. (The fat tissues in this MRI

image have the highest pixel values, we only have to set
the lower limit.)
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We can also change the lower and upper limits values with the mouse wheel.

• Make sure the “Mouse wheel” button show the “Mouse
wheel: Lower limit” text.

250 is not the best value for our segmentation.  We can fine tune this value in a couple of
ways:

Moving the cursor over the subcutaneous fat in the image.  The withe vertical line on the
histogram show the pixel value under the cursor.  You can adjust the lower limit so that all
the fat pixels are under the red portion of the histogram.

We can have a “preview” of what the segmentation will be.

• Click on the “Preview” button.  Its text should now be:
“Preview: ON”

Moving the cursor over the image, you now see an orange overlay on the image.  The
region in orange is the region that would be segmented if you click on the left mouse
button.

The image is darker on the left side than on the right.  If we set the lower limit to a value
low enough to segment the fat tissue on the left side of the image, we can see from the
preview that we will also segment parts of the intra-abdominal fat and some of the internal
muscles.  Instead, we will segment the fat in multiples steps, lowering the threshold at each
step.   This will work because the regions will not grow over previously tagged region
(condition 2 of “How does Region Growing work ?”).

• With the mouse wheel, lower the “lower limit” until it
reaches 170.

With this settings, we still segment part of the intra-abdominal
fat.  The problem is that the sub cutaneous and intra
abdominal fat regions touch each others. 

The contact regions between the sub-cutaneous and intra-abdominal fat are small enough
that by selecting a bigger brush, we can insure that the region growing does not propagate
through the connection. 

• Select the second smallest brush...
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We’ve solved part of the problem, but there is still on overflow
in the intra-abdominal fat on the right hand side of the image.

• Select the 3rd smallest brush...

That did it!  We can now segment the image with these
setting.

• Click on the left button mouse while the cursor is over the
desired fat region.

We will continue the segmentation by progressively lowering the threshold value.

• Select the smallest brush size.

• Place the cursor over an unsegmented region of the sub-
cutaneous fat.

• Lower the “Lower limit” value to 90 using the mouse
wheel.

• Click on the left mouse button.

• Place the cursor over the unsegmented region of the sub-cutaneous fat.
• Lower the “Lower limit” value to 35 using the mouse wheel.
• Click on the left mouse button.

Now we can touch up the few remaining errors left in the segmentation.

• Select the “Paint” mode.

• Select the biggest brush size
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• Paint over the problem regions.  Since the brush is constrained by the
“lower limit” value, you don’t have to worry to mush about painting outside
the region.
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Segmenting Images with Morpho

• Start sliceOmatic, (Start/Programs/TomoVision/sliceOmatic).  

For this exercise, we will need the images Tutor_Morpho_1.gli to Tutor_Morpho_3.gli from
the Tutorial directory.

• Click on the “Medi Browser” button form the “File” menu.

In the “Medi_Browser” window:

• Select the directory “C:\Program
Files\TomoVision\Tutorial” in the
directory list (the left pane in the
Browser’s window).

• Click on the icon for the file
“Tutor_Morpho_1.gli” in the file
selection list, then press the
“Shift” key and click on the
“Tutor_Morpho_3.gli” file, a
green check mark will appear
beside the files indicating that
they have been selected.
(Alternatively, you can use the
“Ctrl” key to add/remove a file
from the selection, or you can click and drag to selected multiple slices.

• Click on the “Read Files” button to read the selected files in sliceOmatic.  Then click on
the “Close” button to get rid of the browser’s window.

We will need 3 tools:

• From the “Tools” menu, select the tools: “Image Info”, “Pixel Info” and
“Color Scheme”
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The images will be visible in the display area of the program.  You can toggle between the
modes “Display One” and“Display All” with the buttons of the “Image Info” tool or with the
“Space bar” on the keyboard.

• Select the mode “Display One” with the image
“Tutor_Morpho_1".

You may want to increase the image contrast a bit:

• In the “Color Scheme” tools’ controls, move the “white”
slider to a value of 250.

You can see that the lower left corner of the image is significantly darker than the rest.  If
we were to use the threshold segmentation technique, this region would create a problem!

Now we use the Mathematical Morphology functions to segment our images.

• Click on the “Morpho” button from the “Mode” menu.

How does Morpho work ?

The Morpho module split the image in regions along it’s “water parting” lines.  A good
way to describe the “water parting” lines is with an analogy: If it rains on a mountainous
terrain, the water will gather into ponds and lakes in the valleys.  The water parting lines
are the ridges of the mountains, they decide into which pond the water will flow.  In other
words, the water parting lines follow the local maxima of the terrain.  The regions
delimited by the water parting lines are the water sheds.
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In medical images, the water parting lines tend to follow the tissue borders, so we will
use them to segment our images.  The problem is that the algorithm create to many
regions, we will have to merge them according to a set of criteria.  This is where the 4
buttons in the morpho mode interface comes in: they control the level of the merges,
going from minimum merge (button “1") to a more aggressive merge (button “4").

The first time one of these buttons is pressed, the water parting and associated merge
for all the selected images will be computed.  If many slices are selected, this may take
some time.  So to move things on a little faster, we have the “compute all” button that
compute the water parting and all 4 merges incrementally.

A good idea would be, if you have a slow machine and a data set of more than 10 slices,
to select all the slices (going from mode one to mode all will automatically select all the
slices), click the “Compute All” button and go take a coffee break!  When you’ll come
back, all the water parting information will be in memory.

Compute the water parting lines and the 4 merges for the image:

• click on the “Compute All” button.

You can now visualize the 4 levels of merges by clicking on the “1", “2", “3" and “4" grey
buttons (beside the param button).  Or alternatively you can use the keyboard “q”, “w”, “e”
and “r” keys.

The merge “4" seems to do a good segmentation, we will use it.

• Click on the grey “4" button.

Now, we will use the regions created by the merge to segment the image.  To be
consistent with the segmentation done by thresholding, we will use the following tags: 1 will
be muscle tissues, 2 will be subcutaneous fat and 3 will be intra-abdominal fat.
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To clearly view the segmented regions when we will create them, select the “Mix” color
scheme

• click on the “Mix” button in the “Color Scheme” window (or
press the “F2" key)

Tagging the subcutaneous regions

Select tag 2 and the smallest brush

• click on the green “2" button in the tag list
• click on the button with smallest circle. Each of these

buttons represent a brush you can use when tagging the
image, the leftmost is a 1x1 pixel square brush.

• for each region of the subcutaneous fat, click once with
the left mouse button when the brush is inside the region.
For example, move the cursor to the coordinate: 70x160
and left-click.

Load this information in the “erase” buffer.  This way, if you make a mistake latter on, and
overwrite one of the regions you’ve just tagged, a simple right-click on the mouse will bring
back your saved work.

• Click on the “Load” button.

Tagging the Muscle

Tag everything inside the subcutaneous region with the tag 1 (we will tag the intra-
abdominal fat latter)

Select tag 1 and the biggest brush
 
• click on the red “1" button in the tag list
• click on the button with biggest circle.
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• Place the cursor inside the body, make sure no part of the
brush overlap the subcutaneous fat regions, and left-click.

• while holding the left mouse button down, move the
mouse around inside the body to tag all the remaining
regions.

You can experiment with the “erase” function of the mouse
(right button) to bring back the information from the erase
buffer.

The main difference between painting in Edit Mode and Morpho mode, is that in edit mode,
you change the pixels under the brush while in morpho mode you change the region under
the brush. 

Tagging the Intra-abdominal Fat

Select tag 3 and the smallest brush
 
• click on the blue “3" button in the tag list
• click on the button with the smallest circle.

• Tag the intra-abdominal fat regions (the fat appears whiter
than the muscle and organs inside the body cavity)

If you have difficulties discerning between fat and non-fat
tissue, you can toggle between the “Grey” and “Mix” color
scheme. (Either with the color scheme buttons or with the
“F1", “F2" keys).

Load your work in the “erase” buffer

• click on the “load” button 
Getting rid of the organs and bones

We will now remove what is not muscle from the tag 1
regions.  
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In the gray level image, we can clearly see that there is muscle between the subcutaneous
fat and the intra-abdominal fat and also, there are organs and bones inside the body cavity.
The water parting lines don’t always differentiate between the 2 (the muscle at position
100x130 is merged with the vertebra at position 130x130).  We will have to use a less
aggressive merge of the water sheds.

Select the “*” tag.  (The “*” is used instead of “0" to underline that this value is treated
differently, “0" is not a tag value, it’s the absence of a tag value.  It is used to remove all
tags inside a region)

• click on the grey “*” button in the tag list.

• un-tag all the regions that are not muscle inside the body
cavity.  

You can use the merge “3" and “2" if needed. 

• Click on the grey “3" and “2" buttons or use the “e” and “w”
keys.

Bones are hard to see in MRI, Morpho did not segment the vertebra correctly, I suggest
you  use the “paint” mode to get rid of the vertebra.

Propagating the segmentation

You can now use the results from this slice as a first approximation of the other slices.

• click on the “Up” button in the propagate box.

The program will now compute the watershed for the second
image and fill each regions with the results of the
segmentation of the first image. 
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You will need to correct the errors created by the semi-
automatic segmentation, but this should be faster than
starting from scratch. 

• click on the “Up” button again to propagate this solution to
the third image.

Again, the proposed solution will have to be refined.  But
please note that each of the slices in the  tutorial are 40mm
apart, in a normal data set, the slices would not  be distanced
by more than a few millimeters, the morphology of the slices
will not change that much, and the proposed solution will be
closer to the desired segmentation.
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Segmenting Images with Threshold and Morpho

• Start sliceOmatic, (Start/Programs/TomoVision/sliceOmatic).  

For this exercise, we will need the images Tutor_Morpho_1.gli to Tutor_Morpho_3.gli from
the Tutorial directory.

• See section 1.3 for details on how to open the images.

We will need 3 tools:

• From the “Tools” menu, select the tools: “Image Info”, “Pixel Info” and
“Color Scheme”

• Select the mode “Display One” with the image
“Tutor_Morpho_1".

You may want to increase the image contrast a bit:

• In the “Color Scheme” tools’ controls, move the “white”
slider to a value of 250.

We will use the Threshold technique to get a first approximation of the segmentation:

• Move the Threshold 1 slider to the valley between the first
2 peeks (background and muscle)  (The threshold value
should be around 45).

• Move the Threshold 2 slider between the fat and the
muscle peek (around 135)
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• Alternatively pressing the F1 and F2 keys will change the Color Scheme from Mix to
Grey, enabling you a good view of the segmentation that will be performed by the
thresholds.

• Click on the Compute Segmentation button to segment
the image.  This action will automatically create the TAG
image associated with this Grey Level Image.

Now we use the Mathematical Morphology functions to complete the segmentation.

• Click on the “Morpho” button from the “Mode” menu.

Compute the water parting lines for the merge “4":

• Click on the grey “4" button.

To clearly view the segmented regions when we will create them, select the “Mix” color
scheme

• click on the “Mix” button in the “Color Scheme” window (or
press the “F2" key)

Now, we will use the result of the threshold segmentation to fill the regions created by the
mathematical morphology algorithm. 

First we need to shrink the result of the thresolding technique to minimize the overflowing
errors:

• click on the “erosion” button twice.
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Now we flood the regions:

• click on the “Flood Watershed” button.

This operation will yield a first approximation of the
segmentation that you can now cleanup using the technique
outlined in section 1.2.
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Segmenting Images with Snakes

In this exercise, we will segment the vertebra in a CT image of the abdomen using the
“Active Contours” or “Snake” technique.

• Start sliceOmatic, (Start/Programs/TomoVision/sliceOmatic).  

For this exercise, we will need the images Tutor_Snake.gli from the Tutorial directory.

• See section 1.1 for details on how to open the image.

• Adjust the controls In the “Color Scheme” tools’ to get a
good contrast on the image, (black to 500 and white to
2000 give good results).

• Click on the “Mix” display mode button.

• Click on the “Snake” button from the “Mode” menu.

How does the Snakes work ?

A Snake is a curve that will tend to minimize its energy.  The energy of a Snake is
composed of 2 parts, its internal energy, computed from its shape and curvature, and
its external energy, computed from the pixel values of the image under the curve.

The Internal Energy

In sliceOmatic, the bending energy of the Snake (part of its internal energy) is controlled
locally.  This energy will determine the minimal curvature the Snake can have.  A “radius”
value is assigned to each point on the Snake curve.  This value is controlled by the
various brush sizes.  When creating a snake, the brush size control the radius value of
all the Snakes points for a portion of the curve.  When editing the curve the brush’s
radius value is assigned to all the points on the Snake touched by the brush.  It can also
be modified globally with the “snake: radius” command.
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The External Energy

When minimizing the energy of the Snake, each of the points of the Snake will be moved
in its immediate vicinity toward the region of the image that has the “best” gradient.  The
“best” gradient is a function of the gradient value and its orientation in respect to the
Snake curve.  The gradient value is derived from the image’s pixel intensities.  The
gradient orientation in respect to the Snake curve will be influenced by the ordering of
the snake’s points (clockwise, counter-clockwise) and the “Polarity” setting. 

The algorithm expect the pixel intensities to be higher on the right hand side of the curve,
as is the case with most CT images.  

If you want to segment a tissue that has a lower grey level value than the surrounding
tissues, you need to tell this to the algorithm!  We do this with the “polarity” button.  The
polarity button does not change the orientation of the curve.  It tells the algorithm
on which side of the curve is the highest pixel intensity.

When creating a Snake, you should systematically:
• Place the points clockwise around the organs to segment
• Place the points counter-clockwise around the holes in the organs
• Use the “Polarity +” if the organ has a higher pixel value than the surrounding tissue.
• Use the “Polarity -” if the organ has a lower pixel value than the surrounding tissue.

The distance that a point can move to latch to a gradient is controlled by the “capture”
range associated to the point.  By default, this value is a function of the “radius” value
of the point.  This value is halved for the “No Polarity” setting.  It can also be modified
globally with the “snake: capture” command.

Sometimes, the Snake will latch to the incorrect gradient. Using the “No Polarity” button
may help in those cases.  With this setting, the algorithm the capture range is halved and
the algorithm will disregard the gradient’s orientation, only taking its magnitude into
account.  It then becomes easier to manually control the curve.

First, we will segment the body.  From the image we noticed that the contour of the body
is fairly round, there are no regions of high curvature.  So we will use the biggest brush
when creating the snake around the body.

• Select the biggest brush
• Select the Tag 1 (red button from the tag list)
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We want to create a new snake.

• Click on the “Create New Snake” button

Now, we draw the first approximation of the snake.  This is done by placing a few points
around the contour of the object we want to segment. The order of the points is important!
The points must be placed clockwise around the object.

Placing and Editing points on the Snake creation curve.

Each new click of the left mouse button will create a new point.  As long as you  don’t
release the mouse button, the point move with the cursor.  If you click on an existing
point, then you can move that point with the mouse.  If you click on the line connecting
2 points, you will insert a new point on that line.  Each point will be represented by a
circle whose  radius reflect the size of the brush used when creating this point.  You can
use different brush side for the points.  You can thus locally control the radius of
curvature of the Snake.

• Starting in the upper left corner of the image, place point
around the body, clockwise, by clicking on the left mouse
button.  When you will minimize the energy of that snake,
the first and last point of the curved will be connected to
create a closed loop.

Now, we want to minimize the energy of the curve we just created.

• Click on the “Minimize Energy” button.  Alternatively,
clicking the middle mouse button also minimize the
snake’s energy.

The program has now compute a Snake that roughly match
the body’s contours.  We will now correct the few errors on the
curve.
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Editing the Snake

The Snake curve is composed of a multitude of closely spaced points.  When you edit
the curve, you act on these points.  There are 2 tools you can use to edit the snake.
Depending on whether you use the left or right mouse button, you will have a repulsing
or attracting brush.

The Repulsing brush (left mouse).  With this brush, you push back the the points
on the snake curve.

The attracting Brush (right mouse).  This brush will attract the points of the snake
curve toward its center.

When you touch the snake’s points with a brush, you also assign the brush’s radius to
that point.  This way, you can locally edit the radius of curvature of the Snake.

• Correct the Snake’s errors by pressing the left mouse
button and pushing the snake curve toward the correct
contours.

• Re-minimize the Snake’s energy.

Now, we will segment the vertebra.  The vertebra has some regions with fairly small
curvature.  We will use the 3rd brush when creating the vertebra’s Snake.

• Select the 3rd brush
• Select the Tag 2 (green button from the tag list)
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• Click on the “Create New Snake” button

• Place points (clockwise) around the vertebra.  We
intentionally create and error.

• Minimize the Snake’s energy.

We must now correct the error we made.

• With the repulsing brush, push the contour of the
snake to close to its desired position.

In the process of editing the Snake, we created a new curve.  We can
delete this curve either by pressing the “delete” key while the cursor is
over the curve, or by selecting the “Delete” button from the tag list and
clicking on the curve.
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• Re-minimize the Snake’s energy.

We now have the vertebra’s contour.  Next, we want to place
a snake around the hole of the spinal cord.  To create a “hole”
in the surface, we must create a counter-clockwise snake
around the hole.

• Click on the “Create New Snake” button

• Place points (counter-clockwise) around the hole.

• Minimize the Snake’s energy.
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Now that we have our Snakes, we want to segment the
images with them.

• Click on the “Snake To Tag” button

The image is now segmented.  We could also convert the
Snake contour to a 3D line with the “Snake To GEOM” button.
This 3D line can then be viewed with the different modes of
the 3D module, or saved with the “Save Geometry” button of
the “File” menu.

The most confusing aspect of the Snake module’s interface is the relationship between the
curve’s clockwise/counter-clockwise orientation, the curve’s polarity and the image’s
gradients.

In the previous example, we used the default value “Polarity +” when creating our Snakes.
Both the body and the vertebra had higher pixel values than their surroundings.

To give an example of the influence of the Polarity setting, we will segment one of the gaz
bubbles in the image.  In this case, the region to segment has a lower pixel value than its
surroundings.  We need to set the “Polarity” of the Snake to “-“.

• Select the 3rd brush
• Select the Tag 3 (blue button from the tag list)

• Click on the “Polarity -“ button

• Click on the “Create New Snake” button
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• Place a few point clockwise around the bubble

• Minimize the Snake’s energy

The resulting snake follows the bubble’s contours.

• If you redo the same steps, but this time with the “Polarity +” setting,
you will notice that the Snake does not follow the bubble’s contour.


